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Linking and Using
Pro/ENGINEER Toolkit

This chapter describes the procedure for linking SimMechanics™ Link
software to the Pro/ENGINEER® computer-aided design (CAD) platform
as a Pro/TOOLKIT application and for exporting CAD assemblies from
Pro/ENGINEER into a form you can use with SimMechanics software.

For general information on installing and using SimMechanics Link software,
as well as demos and examples, see the SimMechanics Link User’s Guide.

• “Registering and Unregistering with Pro/ENGINEER” on page 1-2

• “Supported Pro/ENGINEER Constraints and Their Corresponding Joints”
on page 1-6

• “Configuring SimMechanics Link Settings in Pro/ENGINEER” on page 1-11

• “Exporting Assemblies to Physical Modeling XML Format” on page 1-13

• “Getting Help and Examples” on page 1-17



1 Linking and Using Pro/ENGINEER® Toolkit

Registering and Unregistering with Pro/ENGINEER

In this section...

“Requirements Before Registering” on page 1-2
“Creating a Pro/TOOLKIT Registry File” on page 1-2
“Choices for Registering the SimMechanics Link Utility” on page 1-3
“SimMechanics Link Menu in Pro/ENGINEER” on page 1-4
“Unregistering the SimMechanics Link Utility” on page 1-4

Requirements Before Registering
After you have installed the SimMechanics Link utility, you must register
it with Pro/ENGINEER before you can use it. See “Installing and Linking
SimMechanics Link Software” in the SimMechanics Link User’s Guide.

You must also have a Pro/TOOLKIT registry file for the SimMechanics Link
utility.

Creating a Pro/TOOLKIT Registry File
To complete registration, you must have the following Pro/TOOLKIT
registry text available, either as separate text file or as text ready to be
pasted into an existing file. Consult the documentation that accompanies
your Pro/ENGINEER installation for further details about Pro/TOOLKIT
registration.

Pro/TOOLKIT Registry File for Pro/ENGINEER Wildfire 4 and
Later Versions
The Pro/TOOLKIT registry file text ensures that Pro/ENGINEER treats the
executable SimMechanics Link module as a Pro/TOOLKIT application. Each
line of the registry file text consists of one of a predefined set of keywords,
followed by a value.

Create the registry file text in the following standard form:

name SimMechanics Link
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Registering and Unregistering with Pro/ENGINEER®

startup dll
exec_file $matlabroot/bin/arch/cl_proe2sm.dll
text_dir $matlabroot/toolbox/physmod/smlink/cad_systems/proe/
unicode_encoding false
end

Replace the variables $matlabroot and arch by, respectively, the directory
path to your MATLAB® installation and the operating system architecture;
for example, for 32-bit Windows®, use win32.

Pro/TOOLKIT Registry File for Pro/ENGINEER Wildfire 3 and
Earlier Versions
For the Wildfire 3 and earlier versions of Pro/ENGINEER, you must omit
the next-to-last line in the standard registry file. For Wildfire 3 and earlier
versions, the complete registry file text is:

name SimMechanics Link
startup dll
exec_file $matlabroot/bin/arch/cl_proe2sm.dll
text_dir $matlabroot/toolbox/physmod/smlink/cad_systems/proe/
end

Choices for Registering the SimMechanics Link Utility
Before you can register SimMechanics Link as a Pro/TOOLKIT application,
you must have already installed Pro/ENGINEER and SimMechanics Link
software on your system.

There are two ways to register the SimMechanics Link utility with
Pro/ENGINEER. Either way completes the Pro/TOOLKIT registration of the
SimMechanics Link utility.

Registering Using a Separate Pro/TOOLKIT Registry File
To register using a separate Pro/TOOLKIT registry file:

1 Create a SimMechanics Link Pro/TOOLKIT registry file and save it in an
accessible location on your system. See “Creating a Pro/TOOLKIT Registry
File” on page 1-2.
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1 Linking and Using Pro/ENGINEER® Toolkit

2 Specify the absolute path of this registry file in the PROTKDAT,
PRODEVDAT, and TOOLKIT_REGISTRY_FILE statements of the
Pro/ENGINEER configuration file.

When you open Pro/ENGINEER again, it searches for this registry file by
this absolute path.

Registering Using a Modified Existing Pro/TOOLKIT Registry
File
To register using an existing Pro/TOOLKIT registry file, you must locate
and modify the existing Pro/TOOLKIT registry file in your Pro/ENGINEER
installation.

Copy the contents of the SimMechanics Link registry file into your existing
Pro/TOOLKIT registry file and save the Pro/TOOLKIT registry file.

SimMechanics Link Menu in Pro/ENGINEER
After you register the SimMechanics Link utility with Pro/ENGINEER, the
SimMechanics Link menu appears in the Pro/ENGINEER menu bar.

Unregistering the SimMechanics Link Utility
How you registered the SimMechanics Link utility with Pro/ENGINEER
determines how you unregister it. See “Choices for Registering the
SimMechanics Link Utility” on page 1-3.
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Registering and Unregistering with Pro/ENGINEER®

• If you created a separate SimMechanics Link registry file, remove the
absolute path specification of this registry file from the Pro/ENGINEER
configuration file.

• If you copied the SimMechanics Link registration text into your
Pro/TOOLKIT registry file, delete that text.
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1 Linking and Using Pro/ENGINEER® Toolkit

Supported Pro/ENGINEER Constraints and Their
Corresponding Joints

In this section...

“Degrees of Freedom and Constraints” on page 1-6
“Supported Pro/ENGINEER Constraint Entities” on page 1-7
“Supported Pro/ENGINEER Constraint–Constraint Entity Combinations”
on page 1-7
“Supported SimMechanics Joints and Pro/ENGINEER Connections” on
page 1-9

Degrees of Freedom and Constraints
In Pro/ENGINEER, an unconstrained part has six degrees of freedom (DoFs).
You reduce these DoFs by inserting constraints between bodies. Groups of
constraints, called connections, define particular types of motion.

In SimMechanics models, a body has no DoFs until you connect joints to it.
Each joint is a combination of these joint primitives.

Primitive Abbreviation Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Weld W None 0

CAD translation maps the Pro/ENGINEER constraints between parts to
SimMechanics joint primitives between bodies. In general, the mapping of
constraints to joints is not one-to-one. When you generate a SimMechanics
model from a CAD assembly, the primitives are combined into the appropriate
Joints.
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Supported Pro/ENGINEER Constraint Entities
The SimMechanics Link utility conditionally supports the following
Pro/ENGINEER constraint entities, depending on what constraints they are
combined with.

Entity Description

Circle/Ellipse/Arc Elliptical edge/arc sketch segment*
Cone Conical face
Cylinder Cylindrical face
Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face
Point Vertex/sketch point/reference point

* A circular arc is a special case of an elliptical arc. A complete circle or ellipse
is a special case of a circular or elliptical arc.

Supported Pro/ENGINEER Constraint–Constraint
Entity Combinations
The SimMechanics Link utility conditionally supports the following
Pro/ENGINEER constraint–constraint entity combinations. The combinations
are grouped by constraint according to the structure:

Constraint Entity1 — Constraint — Constraint Entity2

Note A combination listed here might be supported, depending on the overall
geometry of the assembly. A combination not listed here is not supported.

If the SimMechanics Link exporter cannot translate a constraint–constraint
entity combination into a supported SimMechanics joint with DoFs, it
converts the combination into a weld (W) primitive.
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1 Linking and Using Pro/ENGINEER® Toolkit

Align or Mate Constraint Without Offset — Point on Line, Edge
on Surface, or Point on Surface Constraint
The paired entities indicated with a plus (+) sign are supported when linked
with a one of these constraints:

• Align without offset

• Mate without offset

• Point on Line

• Edge on Surface

• Point on Surface

Mate Entity2 Point Line Plane Cylinder Cone Circle/
Ellipse/Arc

Mate Entity1

Point +

Line + +

Plane + + +

Cylinder + + +

Cone + + +

Circle/Ellipse/Arc + + + +

Insert Constraint
The paired entities indicated with a plus (+) sign are supported when linked
with an Insert constraint.

Mate Entity2 Point Line Plane Cylinder Cone Circle/
Ellipse/Arc

Mate Entity1

Point

Line + + +
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Supported Pro/ENGINEER® Constraints and Their Corresponding Joints

Plane +

Cylinder + + + +

Cone + + + +

Circle/Ellipse/Arc + + + +

Align or Mate Constraint with Translational Offset
These entity pairs are supported when linked with an Align or Mate
constraint with translational offset:

• Point — Point

• Plane — Plane

• Line — Plane or Plane — Line

• Plane — Point or Point — Plane

Align or Mate Constraint with Rotational Offset
These entity pairs are supported when linked with an Align or Mate
constraint with rotational offset:

• Line — Line

• Plane — Plane

Supported SimMechanics Joints and Pro/ENGINEER
Connections
The SimMechanics Link utility supports the following SimMechanics
primitives and primitive combinations. The last column lists the equivalent
Pro/ENGINEER connections. The weld (W) is the default target primitive
if the exporter is unable to convert a mate–mate entity combination into a
moving joint.

Primitive
Combination

Description Equivalent
Pro/ENGINEER
Connection

P Prismatic Slider
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1 Linking and Using Pro/ENGINEER® Toolkit

Primitive
Combination

Description Equivalent
Pro/ENGINEER
Connection

PP Planar: P and P are
perpendicular

Planar

PPP Custom
PPPR Custom
S Spherical Ball
R-S Revolute-spherical massless

connector
R Revolute Pin
PR Cylindrical: P and R are

parallel
Cylinder

PPR In-plane: R is perpendicular
to PP

PPPS Six-DoF 6DOF
R-R Revolute-revolute massless

connector
S-S Spherical-spherical massless

connector
W Weld: Rigid with no DoFs Rigid

Tips for Specific Constraints

• You form a spherical primitive with a point-point Align constraint with
zero offset.

• A point-point Align constraint with nonzero offset is translated to a
spherical-spherical massless connector joint. For the translation to succeed,
this constraint must be the only one between the two parts so constrained.

1-10



Configuring SimMechanics™ Link Settings in Pro/ENGINEER®

Configuring SimMechanics Link Settings in Pro/ENGINEER

In this section...

“About the SimMechanics Link Settings Dialog Box” on page 1-11
“Reviewing, Changing, and Applying Export Settings” on page 1-11

About the SimMechanics Link Settings Dialog Box
You can access certain export settings from the SimMechanics Link menu
in your Pro/ENGINEER menu bar. Select Settings to open the settings
dialog box.

Reviewing, Changing, and Applying Export Settings
The SimMechanics Link Settings dialog box contains three active fields
where you can specify linear and angular tolerances as well as relative
roundoff.

When the Pro/TOOLKIT application creates joints from Pro/ENGINEER
constraints, it checks for vector alignments and spacing. Instead of comparing
these alignments and spacings with zero, it compares them with the Linear
tolerance and Angular tolerance that you specify in the dialog box. The
units are meters (m) and radians (rad), respectively. The Relative tolerance
specifies the smallest significant relative numerical difference.

• Click OK to save the settings and close the SimMechanics Link Settings
dialog box.
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• If you do not want to save your settings, click Cancel to close the
SimMechanics Link Settings dialog box.
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Exporting Assemblies to Physical Modeling XML Format

Exporting Assemblies to Physical Modeling XML Format

In this section...

“Export Procedure” on page 1-13
“Automatic Translation of a Rigid Subassembly to an Equivalent Rigid
Body” on page 1-15
“CAD Assembly Export Errors” on page 1-15

Export Procedure
To export a currently open assembly as Physical Modeling XML:

1 From the SimMechanics Link menu, select Export XML. The Select
Directory dialog box opens.
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1 Linking and Using Pro/ENGINEER® Toolkit

2 Choose a directory into which you want to save the exported XML file.
Click Open.

3 A message appears in the message window at the bottom of the
Pro/ENGINEER interface. The message prompts you to enter a name
(without the .xml extension) for the exported XML file. Its default name is
filename.xml, where filename is the name of the current CAD assembly.
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Exporting Assemblies to Physical Modeling XML Format

4 Complete the export by clicking the green check mark button. If you decide
to abort the export, clicking the red “X” button.

If no CAD translation errors occur, another message appears indicating
that the translation is complete and the name and location of the XML file.

You can use the exported XML file to import as a SimMechanics model or
give to another user to import.

STL Files Exported for Each Body
For each body in the CAD assembly, the exporter exports a stereolithographic
(STL) file with geometric information about the body’s shape.

Automatic Translation of a Rigid Subassembly to an
Equivalent Rigid Body
CAD assemblies in Pro/ENGINEER can have subassemblies without
underconstrained components. Each corresponding SimMechanics subsystem,
with each subassembly part translated individually, would have all its
bodies welded to its subsystem ground. Such a translation would result in
an unnecessarily complex SimMechanics model and reduced simulation
performance. The subassembly components could not move relative to one
another in any case.

The exporter automatically detects each such subassembly without
underconstrained components and replaces it with a single equivalent rigid
body in the translated model.

CAD Assembly Export Errors
If CAD translation errors occur:

• The specific CAD constraint errors are written to a separate error log file.

• The Pro/ENGINEER message window confirms that the XML file is still
exported, and models that you generate from this file are valid. However,
these models do not represent the original CAD assembly.
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• An error dialog box opens, indicating the name and location of the exported
XML file and the error log file.

For supported constraints and joints and for model generation instructions,
see “Supported Pro/ENGINEER Constraints and Their Corresponding Joints”
on page 1-6.

STL File Export Errors
If the exporter cannot export an STL file for one or more of the CAD assembly’s
bodies, the Pro/ENGINEER message window displays a warning indicating
for which bodies an STL file could not be created.
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Getting Help and Examples

Getting Help and Examples

In this section...

“CAD Examples Based on Pro/ENGINEER” on page 1-17
“Getting SimMechanics Link Help and Examples from Pro/ENGINEER”
on page 1-17

CAD Examples Based on Pro/ENGINEER
CAD assembly example files are located in the SimMechanics Link demos
area of your MATLAB installation.

You can also view demos by opening the MATLAB Demos browser and
locating the SimMechanics Link entry.

Getting SimMechanics Link Help and Examples from
Pro/ENGINEER
You can open the MATLAB Help browser to the SimMechanics Link
documentation or demos. From the Pro/ENGINEER SimMechanics Link
menu:

• Select Help for documentation.

• Select Demo for demos.

See “SimMechanics Link Menu in Pro/ENGINEER” on page 1-4.
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2

Linking and Using the
SolidWorks Add-In

This chapter explains the procedure for linking SimMechanics Link software
to the SolidWorks® computer-aided design (CAD) platform as a SolidWorks
add-in and for exporting CAD assemblies from SolidWorks into a form you
can use with SimMechanics software.

For general information on installing and using SimMechanics Link software,
as well as demos and examples, see the SimMechanics Link User’s Guide.

• “Linking to and Unlinking from SolidWorks” on page 2-2

• “Supported SolidWorks Mates and Their Corresponding Joints” on page 2-5

• “Configuring SimMechanics Link Settings in SolidWorks” on page 2-10

• “Exporting Assemblies to Physical Modeling XML Format” on page 2-13

• “Getting Help and Examples” on page 2-16



2 Linking and Using the SolidWorks® Add-In

Linking to and Unlinking from SolidWorks

In this section...

“Requirements Before Linking” on page 2-2
“Registering SimMechanics Link Software” on page 2-2
“SimMechanics Link Menu in SolidWorks” on page 2-4
“Unregistering SimMechanics Link Software” on page 2-4

Requirements Before Linking
Before you can register SimMechanics Link with SolidWorks, you must have
already installed SolidWorks and SimMechanics Link software on your
system. See “Installing and Linking SimMechanics Link Software” in the
SimMechanics Link User’s Guide.

After you have installed the SimMechanics Link utility, you must register it
with SolidWorks before you can use it.

Registering SimMechanics Link Software
You must perform two sets of steps to register the SimMechanics Link utility
with SolidWorks, the first from within MATLAB, the second from within
SolidWorks.

Steps in MATLAB
To start registration:

1 Start a MATLAB session with the SimMechanics Link utility already
installed.

2 From the MATLAB command line, enter smlink_linksw. It should return
a message indicating a successful link.

You can now close MATLAB if you want.
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Steps in SolidWorks
To complete registration:

1 Start SolidWorks and close any introductory dialog boxes.

2 Choose Add-Ins from the Tools menu, and then select SimMechanics.
Click OK to complete the link to SolidWorks.

Linking to Multiple Installations of SolidWorks
If you have more than one installation of SolidWorks, the SimMechanics Link
utility is linked automatically to all installations by a single execution of the
smlink_linksw command at the MATLAB command line.

To complete the linking, you must still open each installation of SolidWorks,
select SimMechanics from the Tools > Add-Ins menu, and click OK.

Linking Different SimMechanics Link Installations
You can link only one SimMechanics Link installation at a time to a given
CAD platform. If you want to change the SimMechanics Link installation that
is registered with SolidWorks, you must unlink the existing installation, then
link the other installation.
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2 Linking and Using the SolidWorks® Add-In

SimMechanics Link Menu in SolidWorks
After linking the SimMechanics Link utility, the SimMechanics Link menu
appears in the SolidWorks menu bar if you open a SolidWorks assembly file
(file with extension .SLDASM).

Unregistering SimMechanics Link Software
To unregister the SimMechanics Link utility from a MATLAB session
running on the same computer as your SolidWorks installation, enter the
smlink_unlinksw command at the MATLAB command line.
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Supported SolidWorks Mates and Their Corresponding
Joints

In this section...

“Degrees of Freedom, Mates, and Constraints” on page 2-5
“Supported SolidWorks Mate Entities” on page 2-5
“Supported SolidWorks Mate–Mate Entity Combinations” on page 2-6
“Supported SimMechanics Joints” on page 2-8

Degrees of Freedom, Mates, and Constraints
In SolidWorks, an unconstrained part has six degrees of freedom (DoFs). You
reduce these DoFs by inserting mates (constraints) between bodies.

A SimMechanics body has no DoFs until you connect joints to it. Each joint is
a combination of these joint primitives.

Primitive Abbreviation Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Weld W None 0

CAD translation maps the SolidWorks mates between parts to SimMechanics
joint primitives between bodies. In general, the mapping of mates to joints
is not one-to-one. When you generate a SimMechanics model from a CAD
assembly, the primitives are combined into the appropriate Joints.

Supported SolidWorks Mate Entities
The SimMechanics Link utility conditionally supports the following
SolidWorks mate entities, depending on what mates they are combined with.
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2 Linking and Using the SolidWorks® Add-In

Entity Description

Circle/Arc Circular edge/arc sketch segment*
Cone Conical face
Cylinder Cylindrical face
Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face
Point Vertex/sketch point/reference point

* A complete circle is a special case of a circular arc.

Supported SolidWorks Mate–Mate Entity
Combinations
The SimMechanics Link utility conditionally supports the following
SolidWorks mate–mate entity combinations. The combinations are grouped
by mate according to the structure:

Mate Entity1 — Mate — Mate Entity2

Note A combination listed here might be supported, depending on the overall
geometry of the assembly. A combination not listed here is not supported.

If the SimMechanics Link exporter cannot translate a mate–mate entity
combination into a supported SimMechanics joint with DoFs, it converts the
combination into a weld (W) primitive.
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Coincident Mate
The paired entities indicated with a plus (+) sign are supported when linked
with a Coincident mate.

Mate Entity2 Point Line Plane Cylinder Cone Circle/Arc

Mate Entity1

Point +

Line + +

Plane + + +

Cylinder + + +

Cone + + +

Circle/Arc + + + +

Concentric Mate
The paired entities indicated with a plus sign (+) are supported when linked
with a Concentric mate.

Mate Entity2 Point Line Plane Cylinder Cone Circle/Arc

Mate Entity1

Point

Line + + +

Plane +

Cylinder + + + +

Cone + + + +

Circle/Arc + + + +

Perpendicular Mate
These entity pairs are supported when linked with a Perpendicular mate:

• Line — Line
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• Plane — Plane

• Line — Plane or Plane — Line

Parallel Mate
These entity pairs are supported when linked with a Parallel mate:

• Line — Line

• Plane — Plane

• Cylinder — Cylinder

• Cone — Cone

• Line — Plane or Plane — Line

Distance Mate
These entity pairs are supported when linked with a Distance mate:

• Point — Point

• Plane — Plane

• Line — Plane or Plane — Line

• Plane — Point or Point — Plane

Angle Mate
These entity pairs are supported when linked with an Angle mate:

• Line — Line

• Plane — Plane

Supported SimMechanics Joints
The SimMechanics Link utility supports the following SimMechanics
primitives and primitive combinations. The weld (W) is the default target
primitive if the exporter is unable to convert a mate–mate entity combination
into a moving joint.
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Supported SolidWorks® Mates and Their Corresponding Joints

Primitive Combination Description

P Prismatic
PP Planar: P and P are perpendicular
PPP Custom
PPPR Custom
S Spherical
R-S Revolute-spherical massless connector
R Revolute
PR Cylindrical: P and R are parallel
PPR In-plane: R is perpendicular to PP
PPPS Six-DoF
R-R Revolute-revolute massless connector
S-S Spherical-spherical massless connector
W Weld: Rigid with no DoFs

Tips for Specific Mates

• You form a spherical primitive with a Point-Point Coincident mate.

• A Point-Point Distance mate is translated to a spherical-spherical massless
connector joint. For the translation to succeed, this mate should be the only
mate between the two parts so constrained.
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Configuring SimMechanics Link Settings in SolidWorks

In this section...

“About the SimMechanics Link Settings Dialog Box” on page 2-10
“Reviewing, Changing, and Applying Export Settings” on page 2-10

About the SimMechanics Link Settings Dialog Box
You can access certain export settings from the SimMechanics Link menu
in your SolidWorks menu bar. Select Settings to open the settings dialog box.

Reviewing, Changing, and Applying Export Settings
The settings dialog box contains three active areas.
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Configuring SimMechanics™ Link Settings in SolidWorks®

Message Box
The Message box is a description of the dialog box.

Subassemblies Menu
The Solve Sub-Assemblies Using menu allows you to choose between rigid
and flexible subassemblies.

In SolidWorks, assemblies can have subassemblies, and these in turn can
have sub-subassemblies, and so on. When you select a subassembly in the
SolidWorks feature tree:

1 Right-click the subassembly and select the Component menu, then
Properties. An option appears that allows you to make the component
Flexible or Rigid.

2 Select Rigid (the default) if you are not interested in the motion of the
parts within the subassembly. The subassembly is treated as a single rigid
part and is constrained to move as a single body.

3 Select Flexible if you are interested in the motion of the parts within
the subassembly. Its children (parts and mates within the subassembly)
are treated as dynamically active and can move relative to one another
according to their mates.

• If you select Component properties (the default) in the settings dialog
box, then the add-in respects the internal SolidWorks settings, that is,
Rigid or Flexible, accordingly as each subassembly is configured.

• If you choose Flexible settings in the settings dialog box, however, then
the add-in assumes that all subassemblies are flexible regardless of the
SolidWorks setting. Selecting this option does not change the CAD
subassembly settings in the CAD assembly file.

Assembly Tolerances Subdialog Box
The Assembly Tolerances subdialog box allows you to specify linear and
angular tolerances as well as relative roundoff.

When the add-in creates joints from SolidWorks mates, it checks for vector
alignments and spacing. Instead of comparing these alignments and spacings
with zero, it compares them with the Linear tolerance and Angular
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tolerance that you specify in the dialog box. The units are meters (m) and
radians (rad), respectively.

The Relative roundoff tolerance specifies the smallest significant relative
numerical difference.

Save, Close, and Help Buttons

Click... To...

Save and close the settings dialog box

Close the settings dialog box without saving your settings

Open online SimMechanics Link help
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Exporting Assemblies to Physical Modeling XML Format

Exporting Assemblies to Physical Modeling XML Format

In this section...

“Export Procedure” on page 2-13
“CAD Assembly Export Errors” on page 2-14

Export Procedure
To export a valid assembly, ensure that all the assembly’s parts are fully
resolved first, with all model data loaded into memory. No part should be
lightweight. Refer to the SolidWorks documentation for additional details.

To export a currently open assembly as Physical Modeling XML:

1 From the File menu, select Save As, and then select SimMechanics Link
(*.xml).

The file’s default name is filename.xml, where filename is the name of
the original CAD assembly. You can change the name of the file at this
point, as well as the directory.

2 Click OK. If no CAD export errors occur, a dialog box opens to indicate that
the export is complete and the name and location of the XML file.

You can use the exported XML file to import as a SimMechanics model or
give to another user to import.

STL Files Exported for Each Body
For each body in the CAD assembly, the exporter exports a stereolithographic
(STL) file with geometric information about the body’s shape.
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2 Linking and Using the SolidWorks® Add-In

CAD Assembly Export Errors
If CAD export errors occur:

• The errors are written to a separate error log file.

• The XML file is still exported, and models that you generate from this
file are valid. However, these models do not represent the original CAD
assembly.

• An error dialog box opens listing the CAD mates that could not be properly
translated into joints. The error dialog box also indicates the name and
location of the exported XML file and the error log file.
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For supported mates and joints information, see “Supported SolidWorks
Mates and Their Corresponding Joints” on page 2-5.

STL File Export Errors
If the exporter cannot export an STL file for one or more of the CAD assembly’s
bodies, the error dialog box displays a warning indicating for which bodies an
STL file could not be created.

2-15
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Getting Help and Examples

In this section...

“CAD Examples Based on SolidWorks” on page 2-16
“Getting SimMechanics Link Help and Examples from SolidWorks” on page
2-16

CAD Examples Based on SolidWorks
CAD assembly example files are located in the SimMechanics Link demos
area of your MATLAB installation.

You can also view demos by opening the MATLAB Demos browser and
locating the SimMechanics Link entry.

Getting SimMechanics Link Help and Examples from
SolidWorks
You can open the MATLAB Help browser to the SimMechanics Link
documentation or demos. From the SolidWorks SimMechanics Link menu:

• Select Help for documentation.

• Select Demo for demos.

See “SimMechanics Link Menu in SolidWorks” on page 2-4.

2-16



3

Command Reference



smlink_linksw

Purpose Register SimMechanics Link software as SolidWorks add-in

Syntax smlink_linksw

Synopsis smlink_linksw registers SimMechanics Link software as an add-in to
SolidWorks. It receives no input arguments.

Description You use this command to link SimMechanics Link software to
SolidWorks. You need to register SimMechanics Link software with
SolidWorks before you can use it to export CAD assemblies from
SolidWorks.

Caution

To use this command, you must already have SolidWorks installed on
your system, which must be using the Windows operating system.

If you have multiple installations of SimMechanics Link software, you
can link only one of these installations at a time to SolidWorks.

If you have multiple installations of SolidWorks, registering
SimMechanics Link software with SolidWorks registers it to all of your
SolidWorks installations at the same time.

Outputs If registration succeeds, you see a message indicating that the linking
has worked, with the location of the add-in module.

If registration fails, you see an error message describing the failure.

See Also smlink_unlinksw

3-2



smlink_unlinksw

Purpose Unregister SimMechanics Link software as SolidWorks add-in

Syntax smlink_unlinksw

Synopsis smlink_unlinksw unregisters SimMechanics Link software as an
add-in to SolidWorks. It receives no input arguments.

Description You use this command to unlink SimMechanics Link software from
SolidWorks.

Caution

To use this command, you must already have SolidWorks installed on
your system, which must be using the Windows operating system.

SimMechanics Link software must also have already been registered
with SolidWorks on your system.

If you have multiple installations of SolidWorks, unregistering
SimMechanics Link software from SolidWorks unregisters it from all of
your installations of SolidWorks at once.

Outputs If unlinking succeeds, you see a message indicating that the unlinking
has worked, with the location of the add-in module.

If unlinking fails, you see an error message describing the failure.

See Also smlink_linksw
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